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概要

SiCはすぐれた物理的，化学的特徴を有することから Siに代わる次世
代パワーエレクトロニクス半導体材料として，近年注目されている．現
在，使用されている Si半導体に比べると高耐圧，低損失であり，さらに
熱伝導率が高いことが知られている．そして，Siの 3倍のバンドギャップ
を持ち，また融点が高いことから高温状態でも動作が可能である．
この SiCのバルク成長には昇華法，いわゆる気相成長法が主に使用さ
れている．しかし，Si中の炭素溶解度が極めて低いため，その成長速度
の遅さを理由として，原理的に高品質な結晶を作成することが可能な液
相成長の開発が困難と考えられてきた．
ところが，関西学院大学の金子教授らによって高品質SiCの単結晶を作
製する全く新しい原理に基づいた成長手法が，発明された．これは液相成
長法である準安定溶媒エピタキシー（Metastable Solvent Epitaxy）と呼
ばれている．MSEは全く新しい成長法であり，その成長機構に関しては
不明な点が多い．表面エネルギーがどのような値であるのか，またMSE

において SiC単結晶の結晶表面が原子レベルでどのような構造になって
いるのかは定かではない．
本研究では，MSEの結晶成長は SiCの面方位によって結晶成長や酸化
速度が異なり，結晶成長の様相が違うことから，SiCの表面構造を作成し，
その典型的な面を対象として，第一原理計算を用いて，3C,4H,6H-SiCの
表面エネルギーを計算し，成長しやすい面の検討を行った．その結果，最
も安定な 4H-SiC(11-20)面と最も不安定な 4H-SiCの (0001)面を用いると
最も結晶成長しやすいという知見を得た．
次に，結晶成長の素過程である「放出」「拡散」「吸着」の「拡散」に
注目した．表面拡散のとき結晶表面で原子はどのような経路を辿るのか
検討した．Si面，Si修飾したC面でそれぞれ 3点とり，C原子を付着さ
せた時の第一原理計算を行い，その経路を導きだすことができた．
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第1章 序論

1.1 半導体炭化珪素の歴史
半導体炭化珪素（SiC）は，SiとCという地球上に多く存在する元素か
ら構成されているにもかかわらず，天然には隕石中にわずかに見出せる
だけで，大きな結晶塊は存在しない．しかし，研究上では 19世紀の初め
にはその存在が知られており，歴史的には最も古い化合物半導体の一つ
である．

SiCが半導体として研究されるようになったのは．１９５５年に昇華法
（Lery法）[1]により高純度の SiC単結晶が得られるようになってからで
ある．しかし，レーリー法は自然核発生を利用する結晶成長技術であるた
めに，結晶の大きさは 10mm角ほどで，形も不揃いであったため，工業
的には適さなかった．また，Si素子の驚異的な発展により，SiC素子の研
究開発は 1970年代には下火になってしまった．しかし，1981年にTairov

らによって開発された改良レーリー法により大きな 6H-SiC単結晶のイン
ゴットが得られるようになる．改良レーリー法は，温度勾配を設けた成長
系内を不活性ガスで満たすことにより原料の輸送過程を制御し，さらに
種結晶を使うことにより結晶成長の各生成過程を制御することがバルク
結晶成長法として大きなブレイクスルーとなった．一方，エピタキシャル
成長においては，1987年に（0001）Si面から数度傾いた結晶面を用いる
ことによりステップでの成長を促進させる，「ステップ制御エピタキシー」
が開発され，成長ポリタイプの制御，成長表面の平坦化と成長表面の低
温化が達成された．これと同時期に米国のベンチャー企業から 6H-SiCウ
エハの市販が始まり，良質な基盤結晶とエピタキシャル膜が得られるよ
うになったことで，SiCは半導体素子用材料として再び注目されるように
なった．素子化技術においては，1980年代以降，SiCは多くの青色発光
候補材料で困難であった pn接合が可能であったことから，青色発光ダイ
オード素子の有力な材料として研究開発が進められていた．しかし，1993

年に窒素化合物半導体で高輝度青色発光素子が開発されると，間接遷移
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型半導体である SiCは，研究対象からはずれ，その後は，高パワー，高
周波パワーデバイスが主な研究開発のターゲットとなった．

1.2 SiCの結晶多形
SiCは珪素（silicon : Si）と炭素（carbon : C）の４族原子同士から構
成された唯一の化合物である．SiがCより電気陰性度が大きいことによ
り約 18%のイオン性を持つ共有結合型の結晶で，結晶学的には，同一の
組成で c軸方向に対して多様な積層構造をとることができ，100種類以上
の結晶多形（ポリタイプ）が存在する．ポリタイプとは，一次元的な積層
構造の異なる結晶構造をいう．多くの結晶多形の中でも発生確率が高い
3C-，4H-，6H-SiCの結晶構造を図 1.1に示す．これら結晶多形の表記方
法は，積層方向の単位格子に含まれる Si-C単位層の数と，結晶系の頭文
字（C : 立方晶，H : 六方晶，R : 菱面体）を組み合わせて表されている．
立方晶は 3Cのみで，これをβ - SiC，その他をまとめてα - SiCと呼ぶ
こともある．ポリタイプによって種々の物理的特性が異なるため，応用
上重要な意味を持ってくる [2]．

SiCの全てのポリタイプにおいて，Siと Cの比は１対１で，1/4の C

（1/4の Si）を四つの頂点に配し，中央に Si（C）配した正四面体を基本最
小構造とする．この正四面体を頂点が重なるように配置すると，a，b，c

の三種類の配置が考えられる．また正四面体は面内で 180°回転した配置
をとることができ，このときの配置を a*，b*，c*とする．この三種類の
配置にどの向きの正四面体を重ねていくのかによって SiCのポリタイプ
が形成される．3C-SiCの正四面体の積層順序は abcabcとなり，4H-SiC

と 6H-SiCの積層構造はそれぞれ aba*c*と abcb*a*c*となる．
図 1.2，1.3，1.4はそれぞれ 3C-，4H-，6H-SiCの結晶構造である．赤
線で囲まれているのがそれぞれのユニットセルである．3C-SiCは炭素原
子が 3周期で立方晶をなし，4H-，6H-SiCは炭素原子がそれぞれ 4周期，
６周期で六方晶をなす結晶構造である．

1.3 SiCの物性
SiCは多くの結晶多形が存在し，それぞれ物性が異なる．SiCは Siと比
べて約３倍バンドギャップが大きく，約４倍の熱伝導度と熱の放射能力が
大きいため，大電力制御の半導体デバイスの適用において，高温まで安
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図 1.1: 代表的な SiC結晶多形の結晶構造の（11-20）面へ投影図．●が
カーボン（C），○がシリコン（Si）である．中心に１つの Si，1/4Cを 4

つの頂点に配した正四面体を SiCの最小単位として，この正四面体の積
層周期の違いが SiCにおける結晶多形構造である．
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図 1.2: 3C-SiCの結晶構造．

図 1.3: 4H-SiCの結晶構造．
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図 1.4: 6H-SiCの結晶構造．

定な動作が可能で，破壊に対する耐量が大きい．また，絶縁破壊電解が
Siに比べると大きく，Siパワーデバイスでは困難だった大容量と高速動
作の両立が可能となる [3]．

3C-SiCはポリタイプの中で唯一，立方晶をとり，結晶の対象性が高く，
等方的であるため，デバイス設計が容易である．また，低温において良質
な結晶が作製可能なため，大面積化によるコスト低減や，さまざまなデバ
イスへの応用などが魅力的である．また，従来，デバイス化研究 6H-SiC

が用いられてきたが，4H-SiCの方が移動度は高く，移動度の異方性が小さ
いことから，パワーデバイス作製時に高い性能が期待される．また，SiC

は極性結晶であり，デバイス作製時に 0001面を使う場合には（0001）Si

面と（000-1）C面の選択がある．面方位によって SiCの結晶成長や酸化
速度などが異なることや，成長の様相が違う [4]．そのためデバイス設計
には異方性も考慮しなくてはならない．
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図 1.5: 一般的な半導体材料 (Si，GaAs)と代表的なワイドバンドギャップ
半導体（SiC，GaN，ダイヤモンド）の物性値.

1.4 単結晶SiCの面方位
本研究では，典型的な面である 3面を対象としている．立方晶をなす

3C-SiCは，(111)面，(1-10)面．(11-2)面．また，六方晶をなす 4H-，6H-

SiCでは，(0001)面、(11-20)面，(1-100)面の表面エネルギーの計算を
行った．

(0001)面、(11-20)面，(1-100)面を簡単な六方晶の図とMAYAによって
視覚化された結晶モデルを用いて説明する．また，以下の図では 4H-SiC

の結晶モデルを使用している．

• (0001)面
　この面はα-SiCにとって最も基本となる面である．この面は昇華
法により成長したバルク結晶からも多く切り出せる面であり，貴重
なSiCバルク結晶の有効利用という観点からも最も優れた面である．
結晶学的にこの面を見ると，最表面原子は 1層下の３つの原子と結
合を持っている．そして，最表面原子が Si原子の面を（0001）面ま
たは Si面と呼び，最表面原子がC原子の面を（000-1）面またはC

面と呼ぶ（図 1.6 参照）．SiCは 12%のイオン結合性を有した共有
結合により結ばれており，Si原子と C原子の電気陰性度は異なる．
このため，Si原子はわずかに正に帯電しており，C原子が並んだC

面と Si原子が並んだ Si面はそれぞれ極性を有している．

• (11-20)面
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図 1.6: 単結晶 SiCにおける (0001)面.

　この面は，α-SiCにとって最も基本となる (0001)面に対して垂
直な，代表的な面の一つであり，(0001)から [11-20]方向に 90°傾
けた面である（図 1.7 参照）．この面は，α-SiCの周期的折り返し
構造を反映した Si原子と C原子からなるジグザグの原子配列が表
面を覆う．このため，この面は無極性面であり，電子移動度が高い，
酸化速度が早いなどの特徴を有しており，MOSトランジスターの
基板面として近年注目されている．

• (1-100)面

　この面は，(0001)面と (11-20)面に対して垂直な面であり，(0001)

から [1-100]方向に 90°傾けた面である（図 1.8 参照）．この面は，
最表面の Si原子と C原子が同じ高さで表面を覆う．このため，こ
の面は無極性面で，原子配列より平坦な面を作りやすい．

また，立方晶をなす 3C-SiCの 3面と六方晶をなす 4H-，6H-SiCの 3

面はそれぞれ，(111)面は (0001)面，(1-10)面は (11-20)面．(11-2)面は
(1-100)面に対応している（図 1.9，1.10，1.11参照）．
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図 1.7: 単結晶 SiCにおける (11-20)面.

図 1.8: 単結晶 SiCにおける (1-100)面.
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図 1.9: 単結晶 SiCの立方晶おける (111)面と六方晶における (0001)面.

図 1.10: 単結晶SiCの立方晶おける (1-10)面と六方晶における (11-20)面.
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図 1.11: 単結晶SiCの立方晶おける (11-2)面と六方晶における (1-100)面.

1.5 表面エネルギー
結晶表面近くでは，原子数は内部の対称性の高い完全結晶またはバル
クの原子数に比べて非常に少ないため表面に垂直な方向での対称性が破
れる．また，結晶表面では結晶の結合が切れ (図 1.12参照)ダングリング
ボンドが形成され，不安定な状態になりエネルギーを持つ [5]．この表面
の全エネルギーを表面エネルギーという．この不安定な状態の表面エネ
ルギーは，結晶内部の安定な状態よりも高いエネルギーを持つ．

1.6 準安定溶媒エピタキシー（MSE）
準安定溶媒エピタキシー（MSE）とは関西学院大学の金子教授らによっ
て提案された新たな結晶成長法である．従来の，結晶成長法では温度差
を駆動力としてきたが，このプロセスでは結晶表面のエネルギーの違い
から結晶成長が進む．
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図 1.12: (11-20)面を真空にし，結合を切った 4H-SiCのスラブモデル.
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1.6.1 構造

MSEは二つの SiC(実験では 4H-SiCと 3C-SiC)のウエハーが液体 Siの
薄膜を挟む構造をし，ある一定の温度 (1700℃)のまま結晶成長をさせる
(図 1.13)．その時，熱的に安定な 4H-SiCのウエハーが基板 (seed)，不安
定な 3C-SiCのウエハーが原料板 (feed)となる．
そして，実験結果は等温過程において feed側は溶け出し，seed側にSiC

単結晶が析出した．

図 1.13: MSEプロセスの概略図

1.6.2 状態図

3C-SiCは 4H-SiCよりも準安定であるので，共晶温度は必ず低くなる．
それに伴って，準安定の 3C-SiCの液相線は 4H-SiCの液相線よりも炭素
濃度が大きくなる．したがって，Si-Cの二元系の状態図は図 1.14となる．
3C-SiCと 4H-SiCの共晶反応はそれぞれ破線と実線で示した．
この状態図の横軸は炭素濃度で，０から始まって SiCの単結晶の位置
を 0.5とした．また，縦軸は温度をとり，線を引いてある位置を実験温度
とみなした．
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図 1.14: Si-Cの二元系の状態図

1.6.3 モデル化

MSEの構造から得られた事は液体 Si内では対流が抑制され，溶質の輸
送が拡散方程式にのみ依存する．その事と，挟み込む SiCのウエハーの
二元系の状態図から，MSEにおける結晶成長の濃度プロファイルを単純
にモデル化した．(図 1.15)

1.6.4 MSEプロセスにおける素過程

素過程とは素構造（elementary structure；それ以上分解できない基本
単位）によって構成される構造の挙動のことである．図 1.16にMSEにお
ける素過程を示した．MSEプロセスにおいて素過程となるのは「拡散」，
「吸 着」，「放出」である．
図 1.17に結晶表面の構造を示した．結晶表面は図 1.17に示されている
ようにテラス，ステップ，キンク，空孔に大別する事が出来る．結晶表面
のテラスについた原子はテラスで拡散しながら，徐々にステップの方へ
と近づいて行く．その後ステップからキンクへたどり着き，結合し析出
する．

16



図 1.15: 単純なモデル化

図 1.16: 素過程．
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図 1.17: 結晶表面の構造 [6]．
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第2章 SiCの表面エネルギーの
第一原理計算

2.1 表面エネルギーの計算のながれ
表面エネルギーを求める計算のながれについて簡単に説明する．次の
ような手順で行う．

1. MedeAというソフトウェアを使って 3C-,4H-,6H-SiCのバルクモデ
ル，各面のスラブモデルを作成する．

2. 第一原理計算ソフトはVASP(Vienna Ab-initio Simulation Package)

を用いて１で作成した結晶モデルのエネルギーを求める．

3. VASPで求めた結晶モデルのエネルギーから単位面積あたりの表面
エネルギーを求める．

4. 精度を上げるためスラブの長さを２倍にし，１から３を繰り返す．
そして，計算結果の確認を行う．

以下さらに詳しく説明していく．

2.2 SiCの構造を作成

2.2.1 MedeAについて

MedeAというソフトウェアを使って結晶モデルを作成する．MedeAは、
データベースと第一原理計算の手法を一つのプラットフォームで統合し
た，材料設計支援のための統合ソフトウェアである．グラフィックスイン
ターフェースおよび計算プログラムは全てWindowsシステム上で稼働す
るので、構造の検索，構築，編集，計算，解析までを１つのプラットホー
ム上で行うことができる．
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2.2.2 ユニットセルの作成

原子の位置情報を入力しユニットセルを作成する．MedeAで作成され
た単位格子は周期的境界条件に基づいた，無限に列になるモデルの一部
である．
以下に本研究で使用した3C-SiCの原子位置ファイル (POSCAR)を示す．

(F-43m) 3C-SiC (VASP)

　 1.0

　　　 4.36000000　　 0.00000000　　 0.00000000

　　　 0.00000008 　　 4.36000000 　　 0.00000000

　　　 0.00000008 　　 0.00000008 　　 4.36000000

4 4

Direct

　　　 0.00000000 　　 0.00000000 　　 0.00000000

　　　 0.50000000 　　 0.50000000 　　 0.00000000

　　　 0.50000000 　　 0.00000000 　　 0.50000000

　　　 0.00000000 　　 0.50000000 　　 0.50000000

　　　 0.25000000　　 0.25000000 　　 0.25000000

　　　 0.75000000 　　 0.75000000　　 0.25000000

　　　 0.75000000　　 0.25000000 　　 0.75000000

　　　 0.25000000 　　 0.75000000 　　 0.75000000

前項の原子位置ファイル内の「1.0」は，ユニットセルの倍率を表して
いる．ユニットセルを拡大したい時は「1.05」，縮小したい時は「0.95」
という様に書き換えると，ユニットセルを変化させることができる．次に

4.36000000　　 0.00000000　　 0.00000000

という数字はそれぞれ左から x軸，y軸，z軸を表している．つまり，（x，
y，z）＝（4.36，0.0， 0.0）という意味である．これは，格子定数であり，
単位はÅである．次に，Direct の上の「4　 4」は原子の個数を表してい
る．そして、Directの下の数字は原子の位置を示している．この数字は，
距離ではなく，上の数字の格子定数に対する比で表されている．例えば，

0.75000000 　　 0.75000000　　 0.25000000

という位置の
0.00000000 　　 0.00000000 　　 0.00000000

を基準とした長さを求めたいときは，（x，y，z）＝（4.36× 0.75，4.36

× 0.75，4.36× 0.25）を解けば求めることができる．
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　同様に 4H-,6H-SiCの原子位置ファイルを紹介する．

(P6_3mc) 4H_SiC (VASP)

　 1.0

　　　 3.08000000 　　 0.00000000 　　 0.00000000

　　　 -1.53999993 　 2.66735828 　　 0.00000000

　　　 0.00000018 　　 0.00000032 　　 10.05000000

　 4 4

Direct

　　　 0.00000000 　　 0.00000000 　　 0.00000000

　　　 0.00000000 　　 0.00000000 　　 0.50000000

　　　 0.33333333 　　 0.66666667 　　 0.24982500

　　　 0.66666667 　　 0.33333333 　　 0.74982500

　　　 0.33333333 　　 0.66666667 　　 0.43732500

　　　 0.66666667 　　 0.33333333 　　 0.93732500

　　　 0.00000000 　　 0.00000000 　　 0.18750000

　　　 0.00000000 　　 0.00000000 　　 0.68750000

(P6_3mc) 6H_SiC (VASP)

　 1.0

　　　 3.08000000 　　 0.00000000 　　 0.00000000

　　　-1.53999993 　 2.66735828 　　 0.00000000

　　　 0.00000028 　　 0.00000048 　　 15.12000000

　 6 6

Direct

　　　 0.00000000　　 0.00000000 　　 0.12540000

　　　 0.00000000 　　 0.00000000 　　 0.62540000

　　　 0.33333333 　　 0.66666667 　　 0.79190000

　　　 0.66666667 　　 0.33333333 　　 0.29190000

　　　 0.33333333 　　 0.66666667 　　 0.45840000

　　　 0.66666667 　　 0.33333333 　　 0.95840000

　　　 0.00000000 　　 0.00000000 　　 0.00000000

　　　 0.00000000 　　 0.00000000 　　 0.50000000

　　　 0.33333333 　　 0.66666667 　　 0.66670000

　　　 0.66666667 　　 0.33333333 　　 0.16670000
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　　　 0.33333333 　　 0.66666667 　　 0.33320000

　　　 0.66666667 　　 0.33333333　　 0.83320000

下の図 2.1，2.2，2.3は，以上のファイルの位置情報を入力し，作成し
た結晶モデルである．

図 2.1: MedeAで作成した 3C-SiCのユニットセルの結晶モデル．

2.2.3 スーパーセルの作成

何らかの周期的な原子構造をもつ物質に対して計算を適用するために
ユニットセルからスーパーセルを作成する．バルクモデルの電子状態を
結晶の周期性を利用して現実的な計算によって取り扱うことを可能にす
るが、一般的に、結晶粒どうしが接する粒界や異種物質界面付近の周期
性は結晶自身のものとは異なる．そこで，二次元周期性を持つ界面につ
いて、反転した界面構造を界面に垂直方向にも交互に積層した三次元の
周期構造を考え、その周期的境界条件によってできるセルがスーパーセ
ルである [7]．
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図 2.2: MedeAで作成した 4H-SiCのユニットセルの結晶モデル．

図 2.3: MedeAで作成した 6H-SiCのユニットセルの結晶モデル．
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本研究では，3C-SiCは x軸，y，軸，z軸方向に 2× 2× 2のスーパー
セル,また，4H-，6H-SiCは 2× 2× 1のスーパーセルを使用した．
下の図 2.4，2.5，2.6は，図 2.1，2.2，2.3をMedeAのスーパーセルを
構築するツールである Supercell Builderを使用し作成した結晶モデルで
ある．

図 2.4: 3C-SiCのユニットセルを 2*2*2のスーパーセルにした結晶モデル．

2.2.4 スラブモデルの作成

結晶モデルの表面は表面垂直方向に対して対称性を持たないので、こ
のままでは、バルクモデルに用いるような三次元モデルに対して行われ
る計算を、そのまま適用することができない [8]．結晶モデルの表面に対
して、バルクモデルの計算手法を導入するために，真空層で原子層をサ
ンドイッチした構造（図 2.7，2.8，2.9参照）によって，無限に続く表面
構造を実現するモデルをスラブモデルという．
ここでは表面垂直方向に長いセルであるスーパーセルを使用している
ため，高精度の結晶表面の計算を実現できる．しかし，注意しなくてはな
らないのが原子層と真空層を十分に厚くしなくてはならないことである．
周期的に存在する他のスーパーセル（隣接するセル）の結晶平板が真空
領域を通して相互作用しないように十分広い真空層をとる．また，個々
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図 2.5: 4H-SiCのユニットセルを 2*2*2のスーパーセルにした結晶モデル．

図 2.6: 6H-SiCのユニットセルを 2*2*2のスーパーセルにした結晶モデル．

25



のスーパーセルの結晶平板における二つの表面が、バルク結晶を通して
相互作用しないように十分に結晶平板を厚くしなくてはならない．
下の図 2.7，2.8，2.9は，3C-，4H-，6H-SiCのスーパーセルのスラブモ
デルである．本研究の対象である面の上下に真空層を作成した表面構造
の結晶モデルである．

図 2.7: 3C-SiCスーパーセルの各三面の上下を真空にし，表面構造を模し
た結晶モデル．(a)(111)面におけるスラブモデル，(b)(1-10)面における
スラブモデル，(c)(11-2)面におけるスラブモデル
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図 2.8: 4H-SiCスーパーセルの各三面の上下を真空にし，表面構造を模
した結晶モデル．(a)(0001)面におけるスラブモデル，(b)(11-20)面にお
けるスラブモデル，(c)(1-100)面におけるスラブモデル
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図 2.9: 6H-SiCスーパーセルの各三面の上下を真空にし，表面構造を模
した結晶モデル．(a)(0001)面におけるスラブモデル，(b)(11-20)面にお
けるスラブモデル，(c)(1-100)面におけるスラブモデル
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2.3 平面波基底擬ポテンシャル法
密度汎関数に基づく第一原理擬ポテンシャル法によるバンド計算VASP

codeを用いて計算を行う．この手法では，3次元周期境界条件を満たす
平面波の基底関数を用いて電子被占有の軌道を展開し，その波動関数を
もとに一電子方程式を解くことにより電子状態を求める．交換相関ポテ
ンシャルはGGA(generalizad gradient approximation)を用いた．そして，
擬ポテンシャルとして PAW(projector augmented wave)を用いた．

2.3.1 計算ファイルの説明

VASPの計算を実行させるためには，MedeAで作成した原子モデル以
外にも各ファイルを用意しなければならない．それぞれのファイルがど
のような入力を担うかを簡単に記しておく．

INCAR
計算を制御するための入力パラメーターが収められているファイル．

KPOINTS
計算に使用されるK点を指定するためのファイル．

autocalc
外部緩和における計算を自動でできるシェルスクリプト．

POSCAR
計算する原子モデルの格子定数と原子座標が収められている．

POTCAR
計算し使用されている各元素のポテンシャルが収められている.

res.energy
自動化で計算した際の計算結果が出力されていく．
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2.4 表面エネルギーの計算
物質の表面エネルギーはバルクモデルからその面を切り出すのに必要
なエネルギーとして定義される．バルクモデルのエネルギーとスラブモ
デルのエネルギーから以下のような式で見積もられる．
まず，表面一原子あたりのエネルギー差を求める．Eslabをスラブモデ
ル のエネルギー，Ebulkをバルクモデルのエネルギーとすると表面一原子
あたりのエネルギー差 ∆E は次のように表される．

∆E = Eslab − Ebulk > 0 (2.1)

次に面積を Sとすると単位面積あたりの表面エネルギー Esurf は式 2.2

から求めることができる．

Esurf =
∆E

S
(2.2)

2.5 計算の確認
計算の精度を上げるため，スラブの厚みを２倍にした結晶モデルを作
成し計算の確認をする．例として，3C-SiCの (111)面におけるスラブモ
デルと同じ面でスラブの厚みを２倍にした結晶モデルを下に示す．他の
3C-，4H-，6H-SiCのモデルも同じ方法で作成した．

2.6 計算結果の考察

2.6.1 計算結果

表 2.1，2.2，2.3は，3C-，4H-，6H-SiCのバルクモデルと各面のスラブ
モデルのエネルギーである．これらの値から表面エネルギーを求め，表
2.4と図 2.11にまとめた．

2.6.2 MSEのメカニズム

ここで，もう一度，MSEのメカニズムについて簡単に説明する．MSE

では温度一定で駆動力を濃度差として結晶成長する．そして，面方位に
よって SiCの結晶成長や酸化速度が異なり，結晶成長の様相が違う.
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図 2.10: 3C-SiCの (111)面のスラブモデルと同じ面でスラブの厚みを２
倍にした結晶モデルとの比較．(a)3C-SiCのスラブモデル，(b)スラブの
厚みを２倍にしたスラブモデル

表 2.1: 3C-SiCのバルクモデルと各面のスラブモデルのエネルギー．

結晶モデルの原子の数 エネルギー（eV）
バルクモデル 64 −481.90

(111)面のスラブモデル 12 −83.17

(1-10)面のスラブモデル 16 −114.27

(11-2)面のスラブモデル 48 −348.16
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表 2.2: 4H-SiCのバルクモデルと各面のスラブモデルのエネルギー．

結晶モデルの原子の数 エネルギー（eV）
バルクモデル 32 −240.94

(0001)面のスラブモデル 16 −113.21

(11-20)面のスラブモデル 32 −217.81

(1-100)面のスラブモデル 32 −223.42

表 2.3: 6H-SiCののバルクモデルと各面のスラブモデルのエネルギー．

結晶モデルの原子の数 エネルギー（eV）
バルクモデル 64 −481.90

(0001)面のスラブモデル 24 −173.45

(11-20)面のスラブモデル 32 −325.87

(1-100)面のスラブモデル 32 −335.76

表 2.4: 3C-，4H-，6H-SiCの各面における表面エネルギー (J/m2)．

(0001)面 (11-20)面 (1-100)面
3C-SiC 6.92 3.64 4.47

4H-SiC 7.03 3.42 4.49

6H-SiC 6.97 3.50 4.38
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図 2.11: 表 2.4のグラフ．

図 2.12: MSEの簡単な模式図．
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図 2.12のように 4H-SiC は安定，3C-SiC は 4H-SiC に比べ準安定であ
るので，不安定な 3C-SiCから安定な 4H-SiCへ結晶成長していく．

2.6.3 考察

エネルギーが高いときは不安定，低い時は安定となる．そして，不安
定な物質から安定な物質へ結晶成長していく．つまり，表面エネルギー
の差が大きくなる面の 2面を用いると最も効率よく結晶成長すると考え
られる．図 2.11より最も安定な 4H-SiC(11-20)面と最も不安定な 4H-SiC

の (0001)面を用いると最も結晶成長しやすいと考えられる．

図 2.13: 本研究の結果より考えられる最も効率の良いMSEの簡単な模
式図．
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第3章 結晶表面での原子位置の
第一原理計算

結晶表面での原子位置の第一原理計算を行うにあたり，第 2章と同様
に SiCの構造の作成には原子モデル構築ソフトMedeAを，また，結晶表
面での原子位置の第一原理計算には平面波基底擬ポテンシャル法による
バンド計算VASP codeを使用した．

3.1 計算原理
今回，実験で観測されている 4H-SiC(0001)面の結晶表面での原子位置
の第一原理計算をした．原子の移動経路を導きだすために，4H-SiC(0001)

面スラブモデルの結晶表面である Si面上にC１原子を結合させ，そのC

原子のエネルギーを計算し，その結果から表面拡散時の原子の移動経路
を考察する．

3.2 真空-固体，液体-固体の第一原理計算
今回 MedeA で計算した結果は真空-固体の第一原理計算である．しか
し実際は液体（溶媒シリコン）-固体（4H-SiC）である．そのため実際の
系とは少しずれている．

3.3 計算のながれ
結晶表面での原子位置の第一原理計算ながれについて簡単に説明する．
次のような手順で行う．
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1. 原子モデル構築ソフトMedeAを使って 4H-SiCの (0001)面のスラ
ブモデル，Si面に C１原子を結合させたモデルを作成する．その
際，C原子を z軸方向にリラクゼーションさせ，いくつかの原子位
置におけるエネルギーを計算する．

2. 第一原理計算ソフトはVASP(Vienna Ab-initio Simulation Package)

を用いて１で作成した結晶モデルのエネルギーを求める．

3. VASPで求めたスラブモデルのエネルギーとSi面にC１原子を結合
させたモデルのエネルギーの差を計算し，C原子１つのエネルギー
を求める．

4. 計算結果から表面拡散時の原子の移動経路を考察する．

以下さらに詳しく説明していく．

3.4 Si面とC面
計算を行う結晶モデルでは，4H-SiCの (0001)面の Si面，(000-1)面の

C面に Siを修飾した面におけるC原子の計算をする．
図 3.1に Si面と C面の定義を示した．図 3.1に示されているように Si

面．C面とは結合ボンドが１つの Si-C結合を切断したときに注目する方
向の違いである．Si面，C面とは結合ボンドが切断したとき、Si原子面
が表面となる方向を向いた面が Si面であり，逆にC原子が表面となる方
向を向いた面がC面となる．

3.5 計算手法
図 3.2に表面エネルギー計算を行った結晶構造を示した．黄色のボール
を Si原子，黒のボールを C原子としている．図 3.2に図 3.3のように C

原子を結合させる．図 3.4は図 3.2の上部である Si面を表し，図 3.5は図
3.2の下部である Siを修飾した C面を表している．これらの面での表面
拡散，付着原子位置および原子の付着する面の安定性を解明するため図
3.4の 1～3，図 3.5の 1～3の計６点，そして，それぞれを z軸方向にリ
ラクゼーションさせ，いくつかの原子位置におけるエネルギーを計算を
MedeAで行った．
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図 3.1: Si面とC面の模式図．

図 3.2: 表面計算をした結晶の結晶構造．

37



図 3.3: 結晶表面にC1原子を結合させた結晶構造．
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図 3.4: 図 3.2を上部から見た結晶構造．
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図 3.4の面から 3点取り, 計算を行った．点 1ではすぐ下に炭素原子が
なく空洞になっている．点 2ではすぐ下に炭素原子が存在している点 3は
炭素原子が結合をする場所である．

図 3.5: 図 3.2を下部から見た結晶構造．

図 3.5の面から 3点取り,計算を行った．点 1ではすぐ下に炭素原子が
なく空洞になっている．点 2ではすぐ下に炭素原子が存在している点 3は
炭素原子が結合をする場所である．

3.6 計算結果の考察

3.6.1 計算結果

表 3.1表,3.1は図 3.4，図 3.5でのC原子のエネルギーである．
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表 3.1: 図 3.4の 1,2,3で計算したエネルギーと Siからの距離．

Siからの距離（Å） 1 2 3

0.916183125 −3.94 −2.44 −4.17

0.715183125 −1.62 −4.14 −6.05

0.514183125 20.83 −6.00 −7.43

0.313183125 113.32 −7.38 −8.01

0.212683125 254.17 −8.00 −7.95

0.112183125 718.49 −7.70 −7.66

表 3.2: 図 3.5の 1,2,3で計算したエネルギーと Siからの距離．

Siからの距離（Å） 1 2 3

1.545187500 −2.45 −2.36 −2.36

1.344187500 −3.54 −3.41 −3.42

1.143187500 −4.83 −4.76 −4.71

0.942187500 −5.79 −6.21 −6.12

0.741187500 −3.60 −7.44 −7.62

0.540187500 15.37 −7.82 −8.74

0.339187500 93.04 −6.61 −7.80

0.138187500 529.60 −3.80 −7.94
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表 3.1，3.2から最安定位置と最安定エネルギーを表 3.3,表 3.4にまと
めた．

表 3.3: 図 3.4の 1,2,3で計算した最安定エネルギーと最安定位置．

場所 最安定エネルギー (eV) 最安定位置（Å）
1 −7.82 0.540187500

2 −8.74 0.540187500

3 −5.79 0.942187500

表 3.4: 図 3.5の 1,2,3で計算した最安定エネルギーと最安定位置．

場所 最安定エネルギー (eV) 最安定位置（Å）
1 −8.00 0.212683125

2 −8.01 0.313183125

3 −3.94 0.916183125

3.6.2 考察

図 3.6，3.7に Si面，Si修飾をしたC面にC原子を吸着させた時のエネ
ルギー準位の模式図を示した．図 3.6，3.7よりC原子の拡散には経路が
いくつかあることがわかる．それらC原子の拡散経路の模式図を図 3.8に
示した．図 3.8より拡散には赤色の矢印と青色の矢印の２つの経路が考え
られる．このうち，実際に原子が通る経路は最も活性化エネルギー，つ
まりエネルギーの山が低い経路をとると考えられる．SiCの表面において
は、図 3.6，3.7より，C面を Si修飾した面での経路つまり図 3.8の赤色
の矢印で示された経路を通ることが考えられる．
ここでもう一度，図3.4，3.5に注目する．この結晶表面上で2→1→2→1→2→1→.....

のように 3を通らずに様々な所へ拡散していく．
Si面である図 3.4の場所２が最安定位置であることから，C面よりも Si

面にC原子が付着する方が安定であることがわかった．
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図 3.6: Si面に C原子を吸着させた時のエネルギー準位を示した模式図．
1,2,3は図 3.4に示した吸着サイトをそれぞれ示している．

図 3.7: Si修飾をした C面に C原子を吸着させた時のエネルギー準位を
示した模式図．1,2,3は図 3.5に示した吸着サイトをそれぞれ示している．
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図 3.8: C原子の表面拡散の模式図．1,2,3はそれぞれ計算した原子のサイ
トを表している．
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第4章 総括

本研究では，結晶表面の原子レベルでの構造をモデル化し，第一原理
計算を用いてエネルギーの計算をした．その結果，以下のような知見が
得られた．

• 求めた値から表面エネルギーを計算した．3C-，4H-，6H-SiCの (0001)

面，(11-20)面，(1-100)面の中で最も安定なのが 4H-SiC(11-20)面
と最も不安定なのが 4H-SiCの (0001)面であること．また，本来，
安定であるという結果が多く報告されている (0001)面が本研究で 3

面の中で最も不安定な面であることがわかった（表 2.4参照）．し
かし，これは，(0001)面が polar(極性)界面であることから正確な
値を得にくいことを考慮しなくてはならない．

• Si面，Si修飾した C面で合計６点を取りさらに z軸方向にリラク
ゼーションさせ数カ所の第一原理計算を行った．その結果，図 4.1，
4.2，この結晶表面上で 2→1→2→1→2→1→.....のような 3を通ら
ずに様々な所へ拡散していくことがわかった．また，エネルギー差
が均衡しているため断定はできないが Si面側に最小なエネルギー
が得られた．C側の方が最安定エネルギーと準安定エネルギーの差
が小さかった．これより Si面に C原子が付着する方が安定である
ことがわかった．
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図 4.1: 図 3.2を上部から見た結晶構造．

図 4.2: 図 3.2を下部から見た結晶構造．
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付 録A MedeAによるスラブ
構造の計算の使用法

A.1 セルの作成

A.1.1 モデルウィンドウを開く

Fileでは新しいファイル作成したり，すでにあるファイルを読み込んだ
りすることができる．ここでは，新しいファイルの作成する．

MedeAのメインメニューから「File > New」を選択する．そしたら，周
期境界を示すボックスのみが表示された「Untitled」の名前がついたウィ
ンドウが表示される．

A.1.2 対称性の設定

1. まず，対称性の情報を入力する．

2. MedeAのメインメニューから「Edit > Edit structure... 」を選択
する．または，モデルウィンドウ上でマウス右クリックし，「Edit

Symmetry... 」を選択する．

3. 「Strucute Editor 」が表示される．現在の対称性はP1となってい
る．「Spacegroup:」の右にあるボタンをクリックする．3C SiC の対
称性はF-43m 4H 6H-SiCの対称性は P63mc　なので，「Primitive 」
のリストの中から選択して OK のボタンをクリックする．

A.1.3 格子定数の設定

1. 続いて，格子定数を変更する．デフォルトでは，新しい格子の定数
は a=b=c=10Å, α=β=γ=90°になっている．
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2. MedaAのメインメニューから「Edit > Edit strucute 」を選択し，
「Structure Editor」を開いたら，「Cell」タブを選択する．または，モ
デルウィンドウ上では右クリックし，「Edit Cell...」を選択する．

3. 3C SiCは対称性が F-43mと規定されているため，a軸の長さのみ
変更可能になっている．3C SiCの格子定数はおよそ 4.36Åなので，
A:の右のボックスに 4.36と入力する．

表 A.1: 3C SiCの格子定数の例．
A B C α β γ

4.36 4.36 4.36 90 90 90

4. 4H 6H SiCは対称性がP63mcと規定されているため，a,c軸の長さ
のみ変更可能になっている．4H SiCの a,c軸の格子定数はおよそ
3.08Å，10.05Åなので，A:の右のボックスに 3.08 ，C:の右のボッ
クスに 10.05と入力する．

5. 6H SiCの a,c軸の格子定数はおよそ 3.08Å，15.12Åなので，A:の
右のボックスに 3.08 ，C:の右のボックスに 15.12と入力する．

表 A.2: 4H SiCの格子定数の例．
A B C α β γ

3.08 3.08 10.05 90 90 120

表 A.3: 6H SiCの格子定数の例．
A B C α β γ

3.08 3.08 15.12 90 90 120

A.1.4 原子の入力

1. MedeAのメニューから 「Edit > Edit structure... 」を選択し，
「Structure Editor 」を開いたら，「Add Atom」タブを選択する．ま
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たは，マウス右クリックから「Add Atom..」を選択し，Structure

Editor を開く．

2. まず，C原子を挿入する．Element 部分にはデフォルトでCが入っ
ているので，そのまま SiCのCを挿入していく．Si原子はキーボー
ド入力で Siと変更するか，その右側にあるアイコンをクリックし
て，周期律表を開き Siを選択する．

表 A.4: 3C SiCの原子位置の例．
Name X Y Z

Si 0 0 0

C 0.25 0.25 0.25

表 A.5: 4H SiCの原子位置の例．
Name X Y Z

Si 0 0 0

Si2 0.33333 0.66667 0.25

C 0 0 0.17

C2 0.33333 0.66667 0.43750

表 A.6: 6H SiCの原子位置の例．
Name X Y Z

Si 0 0 0

Si2 0.33333 0.66667 0.66667

Si3 0.33333 0.66667 0.33333

C 0 0 0.125

C2 0.33333 0.66667 0.45833

C3 0.33333 0.66667 0.79167
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A.2 スーパーセルの構築
1. スーパーセルの構築はツールを使用し作成できるため，簡単に説明
する．「 Edit > Build supercells... 」を選択する．

2. 「Supercell Builders」ウィンドウが起動する．「number of cell」に
数値を入力し，OKボタンをクリックするとスーパーセルが構築さ
れたモデルウィンドウが開きます

A.3 スラブモデルの構築
1. スラブモデルの構築はツールを使用し作成できるため，簡単に説明
する．「 Edit > Build surface... 」を選択する．

2. 「Surface Builders」ウィンドウが起動する．「Miller Indices」に数
値を入力し，OKボタンをクリックするとスラブモデルが作成され
ます．

A.4 VASPの計算

A.4.1 計算設定

1. SiCの構造の最適化を計算する．MedeAメインメニューから「Tools

> VASP.4.6」を選択する．しばらくするとメインメニューにVASP.4.6

が追加されるので，「VASP.4.6 > RUN 」を選択する．

2. Calculationタブで以下の設定を行う．

• Type of calculation を Single Point から Structure Optimiza-

tionに変更する．

• Structure Optimization Parametersの 3つのチェックボックス
全てをチェックする．

• Tile は 4H-SiCなら 4H-SiCなどと入力するとよい．

• 設定が終わったらRunボタンをクリックする．
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A.4.2 計算実行

1. キューとプライオリティの指定を行う．

2. キューは takeda3と remoteがありお互い 4つの Jobを実行すること
ができ，それ以上の Jobを実行すると待ち状態 (pending)になる．

3. プライオリティは優先度のことであり，数を多くすると優先度が上
がり，小さくすると優先度が下がる．デフォルトでは5になっている．

4. 設定が終わったらRunボタンをクリックする．

A.4.3 計算結果

1. MedeAメインメニューの「Job Control > View and Job Control 」
を選択する．しばらくすると，ウェブブラウザが起動し，ジョブ制
御画面が現れる．

2. 黒いバーの中あるいはパイパーリンクされている Jobs をクリック
すると，ジョブー覧表が表示される．

3. ジョブの番号が割り当てられている．Statusの部分には現在のジョ
ブの状態が分かる．Status部分には以下の状態が存在する．

4. Statusが finishedになった番号をクリックする．

5. Available Output Filesの一番の上のファイル Job.outをクリックす
る．これのファイルが計算のサマリになる．

6. Job.outファイルの中には計算条件，計算結果 ( 構造，エネルギー，
力，圧力，計算時間 )に関する情報が収められている．構造最適化
計算を行った場合は計算前後の構造についての情報が入っている．
構造最適化の結果，元の格子からわずかに格子が収縮した状態で安
定構造が求まっている．
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付 録B mapleによる表面エネ
ルギーの計算

4H-SiC-2*2*1-001 (0001)面
S:=sqrt(3)*a^2/2;

a:=3.08962*10^(-10);

evalf(S);

1 (1/2) 2

- 3 a

2

-10

3.089620000 10

-20

8.266863511 10

E1:=-120.474557;

E2:=-113.211610;

dE:=(E2-E1)/2;

dE2:=dE*1.60218*10^(-19);

-120.474557

-113.211610

3.63147350

-19

5.818274212 10

G:=evalf(dE2/S);

7.038067348

restart;

4H-SiC-2*2*1-110 (11-20)面　
S:=5.35138*10^(-10)*10.1021*10^(-10);
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-19

5.406017590 10

E1:=-240.949114;

E2:=-217.812981;

dE:=(E2-E1)/2;

dE2:=dE*1.60218*10^(-19);

-240.949114

-217.812981

11.5680665

-18

1.853412478 10

G:=evalf(dE2/S);

3.428424801

restart;

4H-SiC-2*2*1-100 (1-100)面　
S:=10.1021*10^(-10)*3.08962*10^(-10);

-19

3.121165020 10

E1:=-240.949114;

E2:=-223.423598;

dE:=(E2-E1)/2;

dE2:=dE*1.60218*10^(-19);

-240.949114

-223.423598

8.7627580

-18

1.403951561 10

G:=evalf(dE2/S);

4.498165115

restart;

6H-SiC-2*2*1-001 (0001)面
S:=3.09*10^(-10)*2.6761*10^(-10);

-20

8.269149000 10

E1:=-90.34633;
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E2:=-83.148221;

dE:=(E2-E1)/2;

dE2:=dE*1.60218*10^(-19);

-90.34633

-83.148221

3.59905450

-19

5.766333139 10

G:=evalf(dE2/S);

6.973309030

restart;

6H-SiC-2*2*1-110 (11-20)面
S:=5.35224*10^(-10)*15.148*10^(-10);

-19

8.107573152 10

E1:=-361.385329;

E2:=-325.870522;

dE:=(E2-E1)/2;

dE2:=dE*1.60218*10^(-19);

-361.385329

-325.870522

17.7574035

-18

2.845055674 10

G:=evalf(dE2/S);

3.509133523

restart;

6H-SiC-2*2*1-100 (1-100)面
S:=15.148*10^(-10)*3.09011*10^(-10);

-19

4.680898628 10

E1:=-361.385329;

E2:=-335.762479;

dE:=(E2-E1)/2;

dE2:=dE*1.60218*10^(-19);
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-361.385329

-335.762479

12.8114250

-18

2.052620891 10

G:=evalf(dE2/S);

4.385100072

restart;

3C-SiC-2*2*2- (111)面
S:=3.08299*10^(-10)*2.6699477*10^(-10);

-20

8.231422060 10

E1:=-90.2917185;

E2:=-83.171251;

dE:=(E2-E1)/2;

dE2:=dE*1.60218*10^(-19);

-90.2917185

-83.171251

3.56023375

-19

5.704135310 10

G:=evalf(dE2/S);

6.929708219

3C-SiC-2*2*2(1-10)面
restart;

S:=3.08297*10^(-10)*4.36*10^(-10);

-19

1.344174920 10

E1:=-120.388958;

E2:=-114.273044;

dE:=(E2-E1)/2;

dE2:=dE*1.60218*10^(-19);

-120.388958
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-114.273044

3.05795700

-19

4.899397546 10

G:=evalf(dE2/S);

3.644910698

restart;

3C-SiC-2*2*2- (11-2)面
S:=3.08298*10^(-10)*7.5517*10^(-10);

-19

2.328174007 10

E1:=-361.166874;

E2:=-348.160945;

dE:=(E2-E1)/2;

dE2:=dE*1.60218*10^(-19);

-361.166874

-348.160945

6.5029645

-18

1.041891966 10

G:=evalf(dE2/S);

4.475146458
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